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Word Level 1 
Skills Inventory 

 
Name:  _______________________Instructor’s Name:  ____________________________  
Date:  ________________________ 
 

 I 
understand

I somewhat 
understand 

I do not 
understand

Start and quit Word    

Menu bar, toolbar    

Insertion point, entering text    

Open, close, and create a document    

Save a file    

Print a document    

AutoCorrect, Spelling and Grammar Check    

Scroll through a document    

Select text to delete, move, copy    

Edit text (insert, overtype, delete)    

The Clipboard, Clipboard Toolbar, and Clipboard Task 
Pane 

   

Copy and move text    

Previewing documents and setting print options    

Format characters (bold, underline, italicize)    

Change paragraph alignment, spacing and indents    

Create numbered or bulleted lists    

Create text in columns with tables    

Add/delete rows and columns    

Change column widths    

Add borders to tables    

Set page margins and page breaks    
 
 
One thing I would like to learn in this class is _____________________________________  
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Word Level 1 
Skills Evaluation 

 
Name:  _______________________ Instructor’s Name:  ___________________________  
Date:  ________________________ 
 

 I 
understan

d 

I somewhat 
understand 

I do not 
understand

Was not 
addressed

Start and quit Word      

Menu bar, toolbar      

Insertion point, entering text     

Open, close, and create a document     

Save a file     

Print a document     

AutoCorrect, Spelling and Grammar Check     

Scroll through a document     

Select text to delete, move, copy     

Edit text (insert, overtype, delete)     

The Clipboard, Clipboard Toolbar, and 
Clipboard Task Pane 

    

Copy and move text     

Previewing documents and setting print 
options 

    

Format characters (bold, underline, italicize)     

Change paragraph alignment, spacing 
and indents 

    

Create numbered or bulleted lists     

Create text in columns with tables     

Add/delete rows and columns     

Change column widths     

Add borders to tables     

Set page margins and page breaks     
 
 
One thing I wish I had learned in this class is _____________________________________

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 



 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 



 Course # 1671 
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RAMCO 
5113 Pacific Hwy. E. Suite 4 
Fife, WA 98424 
Phone: (253) 922-0299 
Fax: (253) 922-6041 

Word Level 1 
Audience This course is appropriate for those who are familiar with the personal 

computer and Windows.  No previous knowledge of Word or word 
processing is required. 

Description This course uses a combination of lecture, hands on practice, and 
independent exercises to familiarize students with Word.  The four 
fundamental skills in creating a document: entering text, editing, 
formatting, and printing will be covered. 

Objectives Upon successful completion of the class, students should be able to: 
 understand the objects on the screen and use the menu system, 
 enter and edit text, 
 open and save documents, 
 get Help, 
 use Spell Check to edit the document, 
 select and delete blocks of text, 
 move and copy text, 
 preview and print all or a portion of a document, 
 use formatting techniques to change character formats, 
 change paragraph alignment and indents, 
 create numbered or bulleted lists, 
 create and edit text in columns using tables, 
 set page margins and page breaks, 
 insert headers and footers. 

Length 1 day 

Beyond this Level When you have successfully completed this class, the next class you 
should consider is Word XP v10 Level 2.  It will cover templates, 
AutoText, styles, and advanced tables.  Be sure to leave time for 
practice before registering for the next level. 

 

I. Word Processing Basics 
A. Word Processing Benefits and 

Features 
B. Starting Word 
C. Understanding the Screen 
D. Understanding Toolbars & the 

Task Pane 
E. Entering Text 

F. Giving Commands 
G. Saving a Document 
H. Printing a Document 
I. Closing a Document 
J. Opening a Document 

K. Creating a New Document 
L. Using the Office Assistant 
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M. Exiting Word 

II. Basic Editing 
A. Using Spelling and Grammar 

Check 
B. Moving Around a Document 
C. Selecting Text 
D. Inserting and Replacing Text 
E. Deleting Text 
F. Undoing Actions 

III. Expanded Editing Techniques 
A. Using AutoCorrect  
B. Manipulating Windows 
C. Using the Office Clipboard 
D. Moving Text 
E Copying Text 
F. AutoFormat Basics (Optional) 

IV. Previewing and Printing 
Documents 
A. Working in Print Layout View 
B. Previewing a Document with 

Print Preview 
C. Setting Print Options and 

Printing 

V. Changing Character Appearance 
A. Understanding Character 

Formatting 
B. Changing Text Appearance 

(Toolbar) 
C. Changing Font Name and Size 

(Toolbar) 
D. Changing Text Appearance 

(Menu) 

VI. Changing Paragraph Appearance 
A. Understanding Paragraph 

Formatting 
B. Changing Paragraph 

Alignment 
C. Changing Paragraph Line 

Spacing 
D. Creating Paragraph Indents 

F. Creating Numbered and 
Bulleted Lists 

VII. Page Formatting 
A. Setting Page Margins 
B. Setting Page Breaks 
C. Changing Paper 

Size/Orientation 
D. Creating Headers & Footers 

VIII. Basic Tables 
A. What is a Table? 
B. Inserting a Table 
C. Drawing a Table 
D. Using the Tables and Borders 

Toolbar 
E. Typing Text in a Table 
F Selecting Text, Cells, Columns, 

or Rows 
G. Editing Text in a Table 
H. Inserting/Deleting Rows and 

Columns 
I. Adjusting Column Widths and 

Row Heights 
J. Formatting with Borders and 

Shading 

Appendix 
A. Using Find and Replace 
B. Creating and Printing an 

Envelope 
C. Working with Smart Tags 
D. Positioning Text with Tabs 

Glossary 
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 General Information 
COPYRIGHT Copyright 1987-2004 by RAMCO Consulting Services, Inc.  All rights 

reserved worldwide.  No part of this publication may be reproduced, 
transmitted, transcribed, stored in a retrieval system, or translated into 
any language, in any form or by any means without the prior written 
consent of RAMCO Consulting Services, Inc., 5113 Pacific Highway 
East, Suite 4, Fife, WA 98424, USA, (206) 292-4914,  
(253) 922-0299, FAX (253) 922-6041. 

This material cannot be used in the State of Washington, USA without 
the written permission of RAMCO Consulting Services, Inc. 

This material (instructor's manual, student manual, and data) is owned 
by the original purchaser and cannot be resold or transferred to 
another entity without the written permission of RAMCO Consulting 
Services, Inc. 

Disk versions of this courseware may be modified upon payment of a 
license fee to RAMCO Consulting Services, Inc. for use as defined in 
the License Agreement.  If any alterations are made to the information, 
RAMCO is not responsible for the accuracy of the information.  The 
copyright notice and related information is not to be removed from the 
file and should be printed with all hard copies of the courseware. 

DISCLAIMER The use, discussion, demonstration or presentation of hardware and 
software products during this course does not represent an 
endorsement or recommendation of those products. 
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 General Information 
TRADEMARKS This manual is based on software created by one or more of the 

following corporations. 

 Microsoft:  DOS, Windows, Windows Server Family, Excel, Word, 
PowerPoint, Mail, Exchange, Schedule+, Project, Access, Publisher; 
FrontPage, Photo Editor, Image Composer, Outlook, Internet Explorer, 
Visio, ActiveX, Jscript, VBScript 

Lotus:  Lotus Notes 

Adobe:  Photoshop, PageMaker, Acrobat, Illustrator 

Netscape Communications Corporation:  Netscape, JavaScript 

John A. Junod:  WS_FTP 

KIDASA Software, Inc:  Milestones, Etc. 

DENEBA:  Canvas 

Sun Microsystem:  Java 

DESIGN ISSUES This manual has been designed to assist you as you use this program. 
It is intended as a reference manual with the following features: 

• A table of contents is provided for easy reference. 

• An index at the end of the manual references important terms, etc. 

• The manual consists of independent modules covering a specific 
range of related topics with independent exercises at the end. 

• Each page, or series of pages, covers one topic. 

• Graphics and/or diagrams are included to aid understanding.  Dialog 
boxes and other features of the application software may be slightly 
different with different operating systems. 

• Generic steps guide the user through the steps need to accomplish 
a single task. 

• Helpful hints and cautions are provided with appropriate topics. 

• Additional "white" space can be used for personal notes. 
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Word Processing Basics 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

OBJECTIVES 

 

After completing this module, students should be able to: 

• identify the benefits and features of Word, 

• start Word, 

• identify the Word screen elements and toolbars, 

• enter and edit text in a document, 

• save, print, and close a document, 

• open a document, 

• create a new document, 

• use the Office Assistant to get Help, 

• exit Word. 
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Word Level 1 Word Processing Benefits & Features 
OVERVIEW Using a word processing program is similar to using a typewriter to 

type a letter or document.  The most noticeable difference is that the 
document being created is seen on a screen instead of on paper.  To 
produce the document on paper, the computer must be directed to 
print it to a printer. 

Advantages There are many advantages to using a word processing program.  
They include: 

• Speed.  Duplicating or moving words, sentences, paragraphs, or 
whole pages is fast and easy. 

• Revisions.  Changes can be made on the screen before printing. 

• Spell Check.  Spelling and typing errors can be located and 
corrected from a list of suggestions. 

• Clean, perfect copies.  Mistakes are corrected before printing.  
Every copy is an original. 

• Formatting.  A professional-looking document is created. 

• Electronic sharing.  Documents created in Word can be shared 
with others via email or by creating HTML pages to be viewed with a 
browser.  Word documents can also be converted to PDF for 
sharing with those who do not have Word. 

Information entered into Word can be used in other programs. 
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Word Level 1 Word Processing Benefits & Features (cont.) 
Features of Word Word is a word processing program that is very easy to use for the 

beginning word processor, but is also a very powerful program that 
can be used for the “power user” to create sophisticated, highly 
formatted, desktop publishing projects. 

Word has many features.  Some of the capabilities a Word user can 
perform are: 

• enter and edit text easily, 

• format text many different ways, 

• use Spell Check and AutoCorrect to correct mistakes, 

• find and replace text, 

• create page breaks, 

• number document pages, 

• create tables, 

• create AutoText entries to store repetitive text, 

• quickly jump to any page in a document, 

• view multiple documents at once on the screen, 

• create and position footnotes automatically, 

• automatically format text using styles, 

• merge documents for form letters and mailing labels, 

• customize Word features for individual needs, 

• create outlines and rearrange text based on the outline, 

• use templates to expedite document creation, 

• send email, 

• create web pages, 

• use Office Assistant to provide on-line Help. 
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Word Level 1 Starting Word 
OVERVIEW In order to use Word, it must be loaded into the computer's memory.  

In Windows, programs are usually started from the Start button or from 
a shortcut on the desktop. 

Starting Word 

 
 

STEPS 

 

 Start Word. 
Click: Start button 
Point: Programs 
Note: Word may be on another submenu. 
Choose: Microsoft Office 
Choose: Microsoft Office Word 
or 
Double- 
Click: Word shortcut 
Note: Word starts with an empty document window.  The 

new document has the temporary name of Document1.
Note: The Microsoft Word button is displayed on the 

Taskbar. 

1.  Click Start button 

2.  Point to All Programs 

3. Point to Microsoft Office 

A brief description of the 
program functions may 

display; different operating 
systems affect the Word 

software differently 

Or 3. Click New Office 
Document to launch Word 
and start a new document 

based on Normal 

4. Click Microsoft Word 
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Word Level 1 Understanding the Screen 
OVERVIEW When Word is started, it appears in an application window.  Like 

most application windows, it contains a title bar, menu bar, 
toolbars and status bar. 

Document 
Windows 

An application window contains a document window.  The 
document window contains the document being worked on. 

Task Pane The Task Pane is a window through which users can perform 
common tasks such as starting and opening documents, file 
searches, viewing the Clipboard, and formatting.  The Task Pane 
automatically displays when an action that requires its use is 
initiated.  The Task Pane can be displayed and hidden with View, 
Task Pane to allow more space on the screen. 

 

The Word Screen 

 

Ruler 

Control Menu 
button 

Title bar 
Maximize button 

Close button
Minimize button 

Status bar 

Scroll bars 

View 
buttons 

Standard 
and Formatting 

Toolbars 

Menu bar 

Type a 
question 
for help 

box

Task 
Pane 
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Word Level 1 Understanding the Screen (cont.)  
 

The term... Has the meaning... 

application window window that Word runs in. 

document window window that represents a document and 
appears within an application window. 

title bar the bar on the top of a window which displays 
the name of the window.  A new document is 
named Document#  (where # is a number) until 
the document is saved. 

Control Menu button a button that displays a drop-down menu used 
to manipulate a window. 

Minimize button a button that reduces a window to only a button 
on the Taskbar. 

Maximize button a button that enlarges the window to its largest 
size, usually the entire screen. 

Restore button a button that returns a maximized window to its 
previous size. 

Close button a button that closes the window. 

menu bar a line that displays menu names that can be 
clicked to list commands. 

toolbar a bar that contains buttons for performing 
frequently used actions. 

ruler a line that displays paragraph indents, left and 
right margins, tab stops, and the tab alignment 
button. 

Task Pane a window through which users can perform 
common tasks. 

end mark a mark that indicates the end of a document; 
moves down as text is entered; does not 
display in Print Layout View or Web Layout 
View. 

scroll bar a bar on the right side or bottom of a window 
used to move through the contents of the 
window. 

status bar last line of the Word window that displays the 
position of the insertion point, page number, 
section number, and total number of printed 
pages.  The status of some keys is also 
indicated. 
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Word Level 1 Understanding Toolbars & the Task Pane 
OVERVIEW When starting Word, two toolbars (Standard and Formatting) and the 

Task Pane are displayed by default. (The Standard and Formatting 
Toolbars are merged by default.)  These settings can be changed by 
the user.  The changes are saved for the next time Word is started. 

Standard Toolbar The Standard Toolbar includes buttons to create, open, save, or print 
documents; cut, copy and paste, undo/redo actions or commands; 
create a table and many others.  It can also be used to display the 
email form. 

Formatting 
Toolbar 

The Formatting Toolbar includes buttons to change font characteristics 
(i.e. bold, italic, underline); paragraph alignment and indention; format 
numbered or bulleted lists, and many others. 

Task Pane The Task Pane is used to create and open documents, get Help, view 
Search Results, insert Clip Art, Research, view the Clipboard, protect 
documents, apply styles and formatting, reveal formatting, mail merge, 
and more. 

Automatic Toolbar 
Customization 

Like menus, toolbars may not show all buttons.  If a toolbar is too long 
to show all buttons, the least used buttons are not displayed but are 
available under the Expand button.  Additionally, the toolbars 
intelligently share space on the screen based on usage.  Multiple 
toolbars can be merged in a single row.  As a button on a toolbar is 
used, it is “promoted” and displayed in a hierarchical fashion. 

Toolbar Display Which toolbars are displayed and the placement of the displayed 
toolbars can be changed.  The toolbars can be docked (attached to a 
side of the screen) or floating. 

User 
Customization of 
Toolbars 

The Toolbar Options button on the right end of the toolbar allows the 
user to easily customize toolbars.  Buttons for frequently used actions 
can be added and unused buttons can be removed.  New toolbars can 
also be created. 

Using Toolbar 
Buttons 

Pointing to a button with the mouse displays the name of the button.  
Clicking on a button or the drop-down arrow executes that button's 
action. 

Standard Toolbar 

 

Formatting Toolbar 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 



Word Processing Basics Copyright © 1987-04 RAMCO Consulting Services, Inc. 
Page 8  1671-7/7/2004-WG01 

Word Level 1 Understanding Toolbars & the Task  
 Pane (cont.) 
STEPS 

 

 Turn a toolbar display on/off. 
Right-click: in a displayed toolbar 
Note: The View, Toolbars command can also be used. 
Click: name of toolbar to display or hide 

 Turn Task Pane display on/off. 
Choose: View 
Choose: Task Pane 

 Add or remove buttons from a toolbar. 

Click: Toolbar Options button  (found at far right of toolbar) 
Point to: Add or Remove Buttons 
Choose: toolbar name if necessary 
Click: to turn any button on or off 
Note: The Reset Toolbar button resets the toolbar to the 

default buttons. 
Note: The Customize button displays a dialog box to add 

new toolbars, add new toolbar buttons, or other 
customization options. 

Click: outside the drop-down menu to close it 

 Move or float the menu bar or any toolbar. 

Drag: move handle icon  (at far left on toolbar) 
Note: When positioned over the move handle, the mouse 

pointer changes to the move symbol.  

 Dock/Re-dock Task Pane. 
Double- 
Click: Task Pane title bar 
Note: The Task Pane can be moved and closed like any 

other window. 
 
 
 
 

TIPS AND TRAPS 

  

Hint: Use the right mouse button to display or hide toolbars.  Position 
the mouse over any toolbar and right-click. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 



Copyright © 1987-04 RAMCO Consulting Services, Inc.  Word Processing Basics 
1671-7/7/2004-WG01  Page 9 

Word Level 1 Entering Text 
OVERVIEW Once started, Word is ready to create a document.  The insertion 

point, which shows the location for typed characters on the screen, is 
located before the end mark. 

Entering Text Any character (letter, number, or symbol) typed on the keyboard 
appears at the insertion point position and (by default) pushes existing 
text to the right.  When the characters reach the right margin, any word 
that cannot fit within the margin is automatically placed on the next 
line.  This is called word wrap.  To start a new paragraph, press 
ENTER. 

Click and Type Click and Type allows the user to quickly insert text, graphics, tables, 
or other items in a blank area of a document.  If the Click and Type 
mouse pointer displays, double-click at that location to receive the item 
and type.  Word inserts the necessary tab or paragraph alignment.  
Click and Type is only available in Print Layout or Web Layout views. 

The Click and Type pointer indicates how an item will be formatted.  

 

Editing Text After some text has been typed, it may need modifying.  Existing 
characters can be deleted, or additional text can be inserted.  Text is 
always inserted or deleted at the insertion point position. 

Moving the 
Insertion Point 

The insertion point may need to be moved to the proper position 
before changes to the text can be made.  The insertion point can be 
moved with the directional keys on the keyboard or with the mouse.  
The mouse pointer changes shape to an I-beam when positioned in a 
text area.  When the I-beam is at the place to insert text, the mouse is 
clicked to position the insertion point at that position. 

 

The term... Has the meaning... 
Click and Type a special mouse pointer that allows the user to 

quickly insert text, graphics, tables, or other items 
into a blank area of a document. 

I-beam  the mouse pointer shape when positioned over an 
area that accepts text. 

insertion point a blinking vertical bar at the location where 
characters will be inserted or deleted. 

word wrap a feature that causes text to automatically flow to 
the next line if it does not fit within the margins on 
the current line. 
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Word Level 1 Entering Text (cont.)  

 

 
The following are special keys used when entering text 

 

To... Press the key 
combination... 

move the insertion point left or right character by 
character 

LEFT ARROW OR 
RIGHT ARROW. 

move the insertion point up or down a line UP ARROW OR 
DOWN ARROW. 

start a new paragraph ENTER. 
delete the character to the right of the insertion 
point 

DELETE. 

delete the character to the left of the insertion 
point 

BACKSPACE. 

insert a tab at next tab position and move the 
insertion point to that position 

TAB. 

insert a page break CTRL ENTER. 
 

Entering Text 

 

Show/Hide 
button 

Paragraph 
mark 

Word 
wrap 
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Word Level 1 Entering Text (cont.) 
STEPS 

 

 Move the insertion point. 
Position: I-beam at desired location 
Click: left mouse button 
or 
Press: UP, DOWN, RIGHT, OR LEFT ARROWS on the 

keyboard 

 Insert text. 
Click: insertion point at location to insert text 
Type: new text 

 Insert text with Click and Type. 
In Print Layout or Web Layout view, 
Point: mouse pointer until the Click and Type mouse pointer 

or is displayed 
Double- 
Click: at location to receive item 
Note: An insertion point appears. 
Type: text (or insert other item) 

 Remove text one character at a time. 
Click: insertion point before text to be deleted 
Press: DELETE 
Note: If insertion point is positioned after text to be removed, 

press BACKSPACE. 

 Display paragraph marks. 

Click: Show/Hide button  
 
 

TIPS AND TRAPS 

  

Hint: A wavy, red line under a word indicates that the word is not 
found in the Word dictionary.  Point to the misspelled word, and 
click the right mouse button to see a list of suggestions.  Click 
the left mouse button on the correct spelling of the word. 

 

 

Hint: A wavy, green line under a word indicates that there is a 
grammatical error found by the Grammar Checker.  Point to 
the area underlined and click the right mouse button to see a 
list of suggestions.  Click the left mouse button on the 
correction. 
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Word Level 1 Giving Commands 
OVERVIEW The menu bar at the top of the window is used to give commands to 

Word.  By pointing with the mouse to the menu name on the menu bar 
and clicking, a drop-down menu appears and commands are 
available.  For example, the command to save a file, Save, is on the 
File menu.  The shortcut menus, toolbars, and the Task Pane are 
quicker methods of giving commands. 

Menu Bar The commands displayed on the menu may change based on the text 
or object selected or certain keys held when the menu is chosen. 
To expand a menu that is not displaying all commands, double-click 
the menu name, click the Expand button at the bottom of the menu, or 
wait a few seconds after displaying the menu for these commands to 
display. 
Once each menu command is used, it displays upon opening the 
menu.  If a menu command is not used for a while, it will stop being 
displayed on the short version of the menu. 

Dialog Boxes Commands that require more selections display an ellipsis (...) after 
the command on the menu.  The additional selections are presented in 
a dialog box.  Commands without an ellipsis execute immediately. 

Shortcut Keys Many menu commands have shortcut keys.  These appear to the 
right of the command on menus.  Shortcut keys can be used instead of 
the menu to execute commands. 

Corresponding 
Toolbar buttons  

Buttons that appear to the left of menu commands correspond to 
buttons on the toolbars. 

Shortcut Menus A context-sensitive shortcut menu is displayed when the right mouse 
button is clicked in some position in the document.  The commands on 
the shortcut menu are relative to, and frequently used for, the current 
task (determined by the screen location of the mouse pointer when the 
right-click was used).  Commands on the shortcut menu are selected 
with the left mouse button. 

 

The term... Has the meaning 

ellipsis three periods after a command on a menu 
indicating the command displays a dialog box. 

dialog box window appearing on the desktop to supply or 
request information.  Commands on a menu that 
are followed by ellipsis (...) request information 
from a dialog box. 

shortcut key key or combination of keys used to execute a 
command. 

shortcut menu list of useful commands that appear when the right 
mouse button is clicked. 
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Word Level 1 Giving Commands (cont.) 

Sample Menu 

 

Sample Dialog Box 

 

Drop-down 
menu 

Expand button 
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Word Level 1 Giving Commands (cont.)  

Sample Shortcut Menu 

 
 
 

STEPS 

 

 Disable or enable the partial display of menus. 
Choose: Tools 
Choose: Customize 
Choose: Options tab 
Turn on/off: Always show full menus 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

TIPS AND TRAPS 

  

Hint: For a shortcut menu regarding a selection, such as a selected 
word, position the mouse pointer on the selection before clicking 
the right mouse button to display the shortcut menu. 

 

Shortcut menu 
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Word Level 1 Saving a Document 
OVERVIEW The text entered in a document is a temporary copy in the computer's 

memory.  If power is disrupted or the computer is turned off, the 
temporary copy is lost.  In order to create a permanent copy of the 
document, it must be saved. 

Saving a File The File, Save command or the Save button can be used to save a 
file.  If the file has not been saved before, a dialog box appears to give 
the file a name and location.  If the file has been saved and given a 
name previously, the file is saved with the same name. 

File Names The file name must adhere to the Windows file name rules.  Word 
adds the file name extension.  DOC automatically.  Windows contains 
few restrictions on the names of files.  The following rules apply. 

• The complete path, including drive letter, server name, folder path, 
file name, and extension can be up to 255 characters. 

• Most characters including spaces are valid. 

• Characters which cannot be used are: / \ * ? " | : ; < > 

• Characters are not case sensitive; lowercase, uppercase or 
combination can be entered, but they are considered all the same. 

Save As 
Command 

The File, Save As command is used to save a copy of a file under a 
different name or in a different folder or drive.  The File, Save As 
command always displays the Save As dialog box. 

Save As 
Dialog Box 

The Save As dialog box contains the Places bar along the left, which 
provides easy access to the History folder of recently used files, the 
Desktop, the My Documents folder, the My Computer folder and the 
My Network Places folder.  The My Network Places folder allows you 
to browse folders and files on a Web server just like your local drives 
and network shares. 

A Back button in the Save As dialog box lets users easily return to 
recently visited folders, regardless of their location in the folder 
structure. 

AutoRecover Word can be set to automatically save at pre-determined intervals.  
This feature is called AutoRecover; however, it does not replace 
saving the document with the File, Save command.  The AutoRecover 
feature updates a backup file if the power is lost.  When the computer 
is restarted, the Document Recovery  Task Pane lists all the files that 
were recovered when the program stopped responding.  You can open 
the files, view what repairs were made, and compare the recovered 
versions.  You can then save the best version and delete the other 
versions, or save all of the open files to review later. 
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Word Level 1 Saving a Document (cont.)  
Application and 
Document 
Recovery 

In the event of an error, Word can safely close Word and give the 
option to save your work, so the last save can occur before the 
program closes.  Word can then automatically report the error to 
Microsoft who can correct these errors. 

Repair and Extract In the event of an error or a failure to load, Word can automatically 
initiate the repair and recover function to repair the corrupt document.  
Users can also invoke this functionality by choosing Open and Repair 
from the File Open dialog box. 

Options Dialog Box, Save Tab 

 

Check for 
AutoRecover 
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Word Level 1 Saving a Document (cont.)  

Save As Dialog Box 

 
 

STEPS 

 

 Save a document for the first time. 

Click: Save button  
Note: The Save As dialog box displays. 
Type: desired file name 
Choose: desired folder in Save in box if necessary 
Choose: Save 
Note: The File, Save command can also be used. 

 Save changes with the same file name. 

Click: Save button  
Note: The File, Save command can also be used. 
Note:  Word overwrites the old version. 

 Save a copy of the document with a new name or location. 
Choose: File 
Choose: Save As 
Note: The Save As dialog box displays. 
Type: file name 
Choose: drive/folder in the Save in box if necessary 
Choose: Save 

 

Create New 
Folder button 

Current folder 

Folders options for 
saving files 

File name 
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Word Level 1 Saving a Document (cont.)  
STEPS 

 

 Turn on AutoRecover file save. 
Choose: Tools 
Choose: Options 
Choose: Save tab 
Choose: Save AutoRecover info every: On 
Choose: # of Minutes 
Note: The available intervals are from one to 120 minutes. 
Choose: OK 
Note: This only creates a temporary backup in the event of a 

computer malfunction.  It will not save the file if the file 
is closed or Word is exited without saving to a file 
name and location. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

TIPS AND TRAPS 

  
Hint: The shortcut key for Save is CTRL S. 

  

  
Hint: To display the Save As dialog box press F12. 

  

  

Hint: To create a new folder in the current folder, click the Create New
Folder button in the Save As dialog box. 

  

  

Hint: A document can be saved as HTML in the Save As dialog box 
for posting on the Internet or a company intranet. 

 

  

Hint: To save all open documents, macros, AutoText, and templates, 
hold SHIFT, choose File, Save All. 
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Word Level 1 Printing a Document 
OVERVIEW Printing produces a printed copy of the document on paper.  The File, 

Print command or the Print button can be used to print the document.  

Changing Default 
Settings 

Using the Print button prints the entire document using the default print 
settings.  The Print dialog box displays when the File, Print command 
is chosen. Print options such as specific pages to print, number of 
copies, and printer type are available in the dialog box.  It is necessary 
to set the printer type whenever a different printer is used. 

Print Dialog Box 

 

STEPS 

 

 Print one copy of the entire active document. 

Click: Print button  
Note: The File, Print command can also be used. 

 Cancel printing. 
Double- 
Click: printer icon on the status bar. 
Note: The printer icon may quickly disappear for short 

documents.  Then printing cannot be canceled. 
 

TIPS AND TRAPS 

  
Hint: To display the Print dialog box press CTRL P. 

 

Choose number 
of copies 

Choose pages 
to print 
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Word Level 1 Closing a Document 
OVERVIEW When finished with a document, it should be closed to conserve 

memory and taskbar space.  It is not necessary to close one document 
before beginning a new one.  When an existing document is opened or 
a new one is created, and the first was not closed, the new document 
is displayed in a different Word window.  The Word program is then 
running in two (or more) separate application windows. 

Closing with the 
Menu 

The File, Close command can be used to close a document.  File, Exit 
closes all application and document windows that are open. 

Closing with the 
Close Button 

If there is only one application window running, the Close button can 
be used to close the document, but leave Word running.  If more than 
one document is open and one document is closed, the closed 
document’s application window is closed as well.  Any other 
application windows remain open until they are closed. 

Office Assistant 
Close Warning 

Office Assistant prompts to save changes when a document is closed 
and changes have not been saved. 

Closing a File 

 

Close button for 
document 

Control Menu button for 
document window 
(behind File menu) 

Close command 
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Word Level 1 Closing a Document (cont.) 

Warning to Save Changes upon Closing 

 
 
 

STEPS 

 

 Close a document. 
Click: document Close button  
Note: The File, Close command can also be used. 
Note: If changes to the file have not been saved, a dialog 

box appears and prompts to save changes.  Choose 
Yes to save changes.  If the file has not been named, 
the Save As dialog box appears.  Type the file name, 
choose a location, then choose Save. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

TIPS AND TRAPS 

  

Hint: To close all open documents, hold SHIFT and click on File, 
Close All. 

  

 
Hint: CTRL W or CTRL F4 closes the active document. 
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Word Level 1 Opening a Document 
OVERVIEW A document must be copied from the disk into the computer's memory 

in order to be modified or printed.  A file can be located by specifying 
all or part of the file name, or any text contained in the document.  The 
contents of a file can be previewed in the Open dialog box prior to 
opening it.  More than one file can be opened at a time.  There are 
four methods to open a document in Word: 

• File, Open command, 

• Open button, 

• More on the Getting Started Task Pane (New Document Task Pane 
in Word XP), 

• most recently used file list on the File menu or Task Pane. 

Open Dialog Box The Open dialog box contains the Places bar along the left, which 
provides easy access to the My Recent Documents folder of recently 
used files, the Desktop, the My Documents folder, a My Computer 
folder, and a My Network Places folder.  The My Network Places folder 
allows you to browse folders and files on Web server just like your 
local drives and network shares. 

A Back button in the Open dialog box lets users easily return to 
recently visited folders, regardless of their location in the folder 
structure. 

Most Recently 
Used Files List 

By default, Word displays the names of the four most recently opened 
files above the Exit command on the File menu and in the Getting 
Started Task Pane (New Document in Word XP).  If the file to be 
opened is on one of these lists, simply click on the file name to open it. 

Opening Multiple 
Files 

More than one file can be open at a time.  The number of files that can 
be open is limited by the computer's memory.  If a file is currently open 
when another is opened, the new document is displayed in a new 
application window.  The Word program is the same, but it is running 
in two (or more) separate application windows. 

Switching 
Between Open 
Documents 

Any of the open documents can be accessed from the Window menu 
on any of the application windows.  The icons on the taskbar can also 
be clicked to switch between open documents. 

Search for a File The Search feature in the Tools drop-down menu of the Open dialog 
box can be used to find a file to open.  It is especially useful when the 
folder the file was saved in or even the complete file name is not 
known.  Simply type in part of the file name or text that can be found in 
the file, and Search locates all files containing that text. 
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Word Level 1 Opening a Document (cont.)  

Open Dialog Box 

 
 
 

STEPS 

 

 Open a document. 

Click: Open button  
Note: The Task Pane can also be used. 
Navigate: to folder where file is located 
Choose: file name from the list of names 
Choose: Open 

 Open a recently used document. 
Choose: File 
Click: one of the files listed at the bottom of the File menu or on 

the Getting Started Task Pane (New Document Task Pane 
in XP) 

 Open a corrupt document. 

Click: Open button  
Navigate: to folder where file is located 
Choose: file name from the list of names 
Choose: Open and Repair from Open button drop-down 

 

Preview 
Back 
button

Click to change 
locations 

Click file name 
if listed 

 
 
 

or 
 
 
 
 

Type in any part 
of a file name 

Places bar 

Drop down 
for Search 
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Word Level 1 Opening a Document (cont.)  
STEPS 

 

 Preview a document before opening. 

Click: Open button  
Choose: document to preview 

Click: Views button drop-down arrow  

Click: Preview button  
Note: Choose Open to open the file that is being previewed. 

 Find a document that contains specified text. 

Choose: Open button  

Click: Tools button drop-down arrow  
Choose: Search 
In Search text:, 
Type: text to search for 
In Search in: 
Choose: location(s) to search  
Choose: Search 
In Results: 
Choose: file name from list 
Choose: OK 
Choose: Open 

 
 
 
 
 
 
 
 

TIPS AND TRAPS 

  
Hint: To display the Open dialog box, press CTRL O. 

  

  

Hint: Up to nine files can be listed on the Recently Used File List.  
Choose Tools, Options, General tab and change the number of 
entries to nine. 

  

  
Hint: The Task Pane can also be used to search for a file to open. 
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Word Level 1 Creating a New Document 
OVERVIEW A "new sheet of paper" may be needed to start a new document after 

a file is closed.  The New button on the Standard Toolbar and the 
Blank Document option on the Task Pane each create a new 
document using the Word defaults (using the Blank Document or 
Normal template).  A new document also can be created using a 
different template or a wizard. 

Templates A template is a "blueprint" for a document and can include anything 
that can be included in a regular document: text, graphics, formatting, 
etc.  When a new document is created based on a template, all of 
these features are available to the new document.  Word provides 
some templates, and new templates can be created.  The default 
settings for documents are stored in a template called Normal. 

Templates are grouped by category such as General, Legal Pleadings, 
Direct Mail Manager, Letters & Faxes, Mail Merge, Memos, Other 
Documents, Publications, Reports, and Web Pages.  Choose On my 
computer option on the Task Pane to see the list of categories.  Click 
the desired tab to see the templates available. 

Wizards A new document can also be created using a wizard.  A wizard 
prompts for needed information and creates a document with the 
information provided.  Wizards are grouped with templates. 

Multiple Windows More than one file can be open at a time.  The number of documents 
that can be open is limited by the computer's memory.  If a document 
is currently open when another is created, the new document is 
displayed in a new application window.  The Word program is the 
same, but it is running in two (or more) separate application windows. 

Switching 
Between Open 
Documents 

Any of the open documents can be accessed from the Window menu 
on any of the application windows.  The icons on the taskbar can also 
be clicked to switch between open documents. 

 

The term... Has the meaning... 

template a file that may contain saved formatting, text, and 
graphics used as a pattern for a new document. 

wizard a feature that creates a document using responses 
to questions the wizard asks. 
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Word Level 1 Creating a New Document (cont.)  

Templates Dialog Box 

 
 
 

STEPS 

 

 Create a new document accepting all defaults. 

Click: New button  
Note: A new window appears with Document# in the title 

bar. 
Note: The Blank Document option on the Task Pane can 

also be used. 

 Create a new document using a template or wizard. 
Choose: File 
Choose: New 
Note: The New Task Pane displays 
Choose: On my computer (General Templates in Word XP) on 

the Task Pane 
Note: If necessary click desired tab. 
Choose: desired template 
Choose: OK 
Note: If using a wizard, continue through wizard dialog 

boxes making selections as requested. 
 

The Blank Document 
template for a 

document based on 
Word defaults is under 

the General tab 
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Word Level 1 Using Microsoft Office Word Help 
OVERVIEW Word contains built-in Help information, which is accessed via the 

Office Assistant, the Microsoft Office Word Help button on the 
Standard Toolbar, the Help menu, the Task Pane, or the Type a 
question for help box.  Online Help is available through Microsoft’s 
web site if Help cannot provide the needed information.  The Help 
feature is same as that available throughout the Microsoft Office 
suite. 

Office Assistant 

 

The Office Assistant is an animated interactive program that offers 
help and shortcuts.  It can be hidden and redisplayed using the Help 
menu.  If the Office Assistant is displayed, it functions outside of a 
window directly over the user’s work.  The Office Assistant suggests 
topics related to the information on the screen, as well as offering a 
search feature and tips.  Select a topic bullet to see the information, 
or type a question, and choose Search.  Results are displayed in the 
Search Results Task Pane. 

Customizing the 
Office Assistant 

There are several personalities available that can be customized to 
offer help with or without being asked.  Different levels of assistance 
can be set to suit individual needs.  Options include using features 
more effectively, keyboard shortcuts, and displaying alerts. 

Help Menu and 

Button  

The Help menu allows access to the different Help commands.  The 
Help, Microsoft Office Word Help command and the button on the 
Standard Toolbar display the Help Task Pane.  Help topics are typed 
in the Search for box.  Results are displayed in the Search Results 
Task Pane. 

The Help 
Task Pane 

The Help Task Pane is a resource that provides a variety of different 
Help options.  Words or phrases can be typed in the Search box to 
return a list of possible answers (in order of relevance with the most 
likely answer to your question at the top), or click the Table of 
Contents link to browse for the help you need.  When you are 
connected to the Internet, the information available to you from the 
Help Task Pane includes all of the up-to-date Help topics and 
templates that are most likely to provide the answers to your 
questions as well as direct links to training courses, product updates, 
clip art, and more on Microsoft Office Online. 

The Search Results 
Task Pane 

All search results are displayed in the Search Results Task Pane.  
Clicking a topic link opens an additional window and displays the 
information for that topic.  Topics can then be printed if necessary. 

The Type a 
Question for Help 
Box 

 

The Type a question for help box is displayed by default in the upper-
right corner of the screen.  Simply type your question in the box.  
Results are displayed in the Search Results Task Pane. 
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Word Level 1 Using Microsoft Office Word Help (cont.) 
Microsoft Word 
Help Icon  

The Microsoft Word Help icon  is found in many of the dialog boxes.  
It takes you right to the Help screen related to the task being 
addressed by the open dialog box. 

 

Word Help Task Pane 

 

Word Help Table of Contents 

 

Office Assistant Type a Question for 
Help Box 

 

Microsoft Office 
Word Help Button 

 

 

 

Click to access the 
Help Table of Contents 

Type in information to 
search for 
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Word Level 1 Using Microsoft Office Word Help (cont.) 

Options for Accessing Help 

 
 
 

STEPS 

 

 Show/Hide the Office Assistant. 
Choose: Help 
Choose: Show/Hide the Office Assistant 

 Disable the Office Assistant. 
Click: Office Assistant character 
Choose: Options 
Choose: Options tab 
Clear: Use the Office Assistant checkbox 
Choose: OK 

 Display the Help Task Pane. 

Click: Microsoft Office Word Help button  
Note: The Help, Microsoft Office Word Help command can 

also be used, as can F1. 
 

Clicking the character 
displays a cartoon 
balloon dialog box 

Type a question and 
click Search button 

Type a question in the 
Ask a Question box 

Type a question in the 
Help or the Search 

Results Task Panes 

Click the Microsoft Office 
Word Help button to display 

the Help Task Pane 
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Word Level 1 Exiting Word 
OVERVIEW When all work in Word is finished, Word should be exited.  When 

Word is exited, it checks to see if all documents, AutoText entries, 
templates, etc. have been saved.  If not, Office Assistant prompts to 
save the changes.  Any defaults changed while using Word are also 
saved for the next session. 

Exiting Word can be accomplished by: 

• clicking the Word Close button, 

• double-clicking the Word Control Menu button, 

• choosing the File, Exit command. 

Exiting Word 

 
 
 

STEPS 

 

 Exit Word. 
Choose: File 
Choose: Exit 
or 

Click: Word Close button  
Note: The Word Close button exits Word if only one Word 

application window is open. 
 
 

The application Close button 
exits Word if only one Word 
application window is open 

Word Control 
Menu button 

File, Exit command 
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Word Level 1 Word Processing Basics Level 1 
OBJECTIVES You will enter text in a document, save, and close the document. 

REAL WORLD  

Your boss at Midtek knows you have been exploring Word.  He has 
asked you to type a memo announcing the hiring of a new employee.  
A draft of the memo follows. 

TASKS Type the memo that follows.  Save it as Terry Taylor 
Announcement.  Read the document over and correct any errors.  
Save the document again and close it. 
 

 
 

This may wrap 
differently on your 

screen. 

We are happy to announce the addition of a new representative, 
Terry Taylor, to our sales force.  Terry brings a significant amount of 
experience and expertise to the position and will help us in achieving 
our sales goals for the coming years. 

Please join us in welcoming Terry to our team.  You can meet Terry at 
the staff meeting scheduled for next Monday. 

HINTS 
 

 

To... Use the 
Menu or 

Task Pane... 

Or the 
Shortcut... 

Notes 

create a new 
document if 
necessary 

Blank 
Document  

A new document is 
already started when 
you first start Word. 

type the above 
memo 

  Do not press ENTER 
until the first 
paragraph is finished.

save the 
document 

File, Save 
 

Type Terry Taylor 
Announcement as 
document name, and 
choose Save. 

correct errors   Use the DELETE or 
BACKSPACE key 
and retype text to 
correct errors. 

resave the file File, Save 
 

 

close the file File, Close 
 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 



Word Processing Basics Copyright © 1987-04 RAMCO Consulting Services, Inc. 
Page 32  1671-7/7/2004-WG01 

Word Level 1 Word Processing Basics Level 2 
OBJECTIVES You will enter text in a document and save it.  You will then add some 

text, print, and close the document. 

REAL WORLD  

Your department at Midtek recently received a letter from a potential 
customer requesting information about Midtek.  You must type a letter 
responding to the customer.  A draft of the letter follows. 

TASKS Type the letter that follows.  Save it as Kletke Inquiry.  Read the 
document over and correct any errors.  Save the document again. 
 

 
 
 
 
 
 
 
 
 
 

This may wrap 
differently on your 

screen. 

(type today's date) 

 

John Kletke 
4196 Corporate Drive 
Silver City, WA 98888 

Dear Mr. Kletke: 

We at Midtek welcome your inquiry into our products.  We are 
enclosing a brochure of who we are and what it is we produce.  If you 
have any questions, please call our customer service line. 

Thank you! 

 

Sara Blithe 
Vice President, Midtek 

HINTS 
 

 

To... Use the 
Task 

Pane... 

Or the 
Shortcut... 

Notes 

create a new 
document 

Blank 
Document  

 

type the letter   Press ENTER to create a 
new paragraph after 
short lines such as the 
address block. 
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Word Level 1 Word Processing Basics Level 2 (cont.)

REAL WORLD  
After reading over the letter you just typed, you notice that you forgot 
to include the customer service telephone number. 

TASKS If you did not complete TASK 1, open Basics Exercise 2 Copy 
Of Kletke Inquiry, otherwise open the document you created 
(Kletke Inquiry).  Add "at 1-800-343-2121" after "customer 
service line" at the end of the first paragraph.  Type your initials two 
lines below the last line of the document.  Save, print, and close the 
file. 

HINTS 
 

 

To... Use the 
Menu or 
the Task 
Pane... 

Or the 
Shortcut... 

Notes 

open the 
document you 
created (Kletke 
Inquiry) 

File, Open 
or More 
documents 

 or 
Most 
recent file 
list on File 
menu 

If you did not complete 
TASK 1, open 
Basics Exercise 
2 Copy Of Kletke 
Inquiry. 

add the phone 
number 

  Position the insertion 
point before the period 
at the end of the first 
paragraph (after 
"customer service 
line").  Type "  at   1-
800-343-1212."  (Do 
not type quotes.) 

add your initials   Position the insertion 
point at the end of the 
document and press 
ENTER twice before 
typing your initials. 

print the 
document 

File, Print 
 

File, Print displays a 
dialog box to change 
print options. 
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Word Level 1 Word Processing Basics Level 3 
OBJECTIVES You will enter text in a document and save it.  This exercise includes a 

challenge step to spell check the document. 

REAL WORLD  

You would like to create a document summarizing the topics covered 
in the previous lesson to help you remember them.  You are curious 
about the Spell Check feature and decide to try it out. 

TASKS Create a new document summarizing the topics from the previous 
lesson, including some of the benefits and features of using Word. 

Save the document with a file name of your choice. 

Challenge:  Spell check the document. 

Save again. 

Print (optional). 

Close the file. 

HINTS 
 

 

To... Use the 
Menu... 

Or the 
Shortcut... 

Notes 

spell check the 
document 
(challenge) 

Tools, 
Spelling 
and 
Grammar 

 
If the Spell Check finds 
a word it does not 
recognize, you must 
ignore or change the 
word. 
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Word Level 1 Index 
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Multiple 22, 23 
Name 15 
Open 22 
Page Setup 134, 135, 136, 139, 140 
Print 19, 85, 86 
Save 15 

Find 
File 23, 24 

Font 101, 102, 104 
Color 98, 99, 100, 104 
Dialog box 103, 104 
Formatting 98, 99, 100 
Formatting Quick Keys 105 
Style 104 

Font dialog box 
Color 104 
Effects 104 
Font 104 
Font Style 104 
Size 104 
Underline Styles 104 

Footer 
Create a 141, 142, 143 
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Form 
Create 150 

Format 
After Typing 114 
AutoFormat 69, 70, 71 
Automatically 69, 70, 71, 97, 124, 125 
Before Typing 114 
Border 166, 167, 168 
Characters 96, 103, 104 
Defaults 96 
Font 98, 99, 100 
Font dialog box 103, 104 
Format Painter button 96 
Margins 96 
Mark inconsistent formatting 69 
Page 96 
Paragraphs 96, 114 
Reveal Formatting Task Pane 96 
Sections 96 
Shading 166, 167, 168 
Text 96 

Format Painter 
Button 98, 99, 100, 101, 102 

Formatting Toolbar 5, 7, 98, 99, 100, 101, 102, 
114, 116, 117, 120 
Displaying 100 

Full Screen. 82 

G 

Grammar 
Checking 11, 36, 37, 38 

Gridlines 151, 152, 153, 154 

H 

Hanging indent 120, 121, 122, 123 
Header 

Create a 141, 142, 143 
Header Footer Toolbar 141, 142, 143 

Buttons 142, 143 
Header/Footer 

View 141, 142, 143 
Help 20, 27 

Answer Wizard 27, 28 
Ask a Question Box 27 
Contents 27, 28 
Finding 28 
Index 27, 28 
Menu 27 
Options 27 

Hide/Display button 10, 11 

I 

I-beam 9, 10, 11 
Increase Indent 

Button 120, 121, 122, 123 

Indent 
Hanging 120, 121, 122, 123 
Markers 120, 121, 122, 123 
Paragraph 115, 120, 121, 122, 123 

Index 
Help 27, 28 

Insert 
Multiple Rows and columns 162, 163 
Table 162, 163 
Table button 151, 152 
Table command 151, 152 
Text 45, 46, 158 

INSERT 
Key 45, 46 

Insert Table 
Dialog box 152 

Insertion point 9, 11 
Move 9, 10, 40 

Insertion Point 
Move 39, 41 

K 

Key 
Navigation 9, 10 
Shortcut 12 

L 

Landscape 
Orientation 139, 140 

Line 
Spacing 118, 119 

Load 
Word 4 

M 

Magnifier 82, 83, 84 
Margins 

Change in Print Preview 82, 83, 84 
Change with the menu 134, 135, 136 
Change with the ruler 134, 135, 136 
Formatting 96 
Set 134, 135, 136 

Maximize button 6 
Menu 

File, Close 20 
Help 27 
Sample menu 13 
Shortcut 12, 14 
Use menus 12 
Window 22, 23, 25 

Menu bar 5, 6, 12 
Minimize button 6 
Most Recently Used 

Files 22, 23 
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Move 
Insertion point 9, 10, 11, 39, 40, 41 
Text 64, 65, 66 
With keyboard 10 
With mouse 10 
With the keyboard 39, 40, 41 
With the mouse 39, 40, 41 

Multiple 
Files 22, 23 
Windows 25 

N 

Navigating 
Documents 39, 40, 41 
Navigation key 9, 10 
With the Keyboard 39, 40, 41 
With the Mouse 39, 40, 41 

New 
Button 26 
Dialog box 26 
Document 25, 26 

Normal view 80, 81 
Numbered List 124, 125 
Numbering 

Paragraphs 124, 125 

O 

Objects 
Deleting 47 

Office Assistant 20, 27 
Customize 27 
Options 28 

Office Clipboard 61, 62, 64, 65, 66, 67, 68 
Online Layout view 80 
Open 

Button 22, 23, 24 
Dialog box 22, 23, 24, 25 
Document 22 
File 22 

Orientation 
Change 140 
Changing 139 
Landscape 139, 140 
Portrait 139, 140 

Outdent 120, 121, 122, 123 
Outline view 80 
Overtype 45, 46 

P 

Page 
Formatting 96 

Page break 
Control 137, 138 
Create 137, 138 
Display 137, 138 
Hard 137, 138 
Insert 137 
Soft 137, 138 

Page Setup 134, 136 
Dialog box 135, 139 

Pane 59 
Task Pane 5, 6, 7 

Paper size 
Change 139, 140 

Paragraph 
Alignment 115, 116, 117 
Bulletting 124, 125 
Dialog Box 119, 121, 122, 123 
Formatting 96, 114 
Indenting 115, 120, 121, 122, 123 
Numbering 124, 125 
Outdent 115 
Spacing 118, 119 

Paste 61, 62, 64, 65, 66, 67, 68 
Smart Tag 61 
Text into a table 161 

Point 101, 102, 118, 119 
Portrait 

Orientation 139, 140 
Preview 

Document 23 
Print Preview 80 

Print 
Button 19 
Cancel 87 
Change paper options 87 
Change selected printer 87 
Command 85, 86 
Dialog box 19, 85, 86 
Dialog box options 86 
File 19 
Options 19 
Print Preview 80, 82, 83, 84 
Properties 85, 86, 87 
Zoom 82, 83, 84 

Print button 
Print Preview 85, 86 
Standard Toolbar 85, 86 

Print Layout view 80, 81 
Print Preview 23, 83, 84, 136 

Buttons 82, 83, 84 
Magnifier 82, 83, 84 
Margins 82, 83, 84 
Print button 85, 86 
Ruler 82, 83, 84 
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Properties 
Document 85, 86, 87 
Printing 85, 86, 87 

Q 

Quick Keys 114, 118, 123 
Font Formatting 105 
Formatting 116, 117 

R 

Recovered 
File 15 

Redo 48 
Button 48 

Remove 
Table 162, 163 

Repeat Key 
F4 105 

Replacing 
Text 45, 46 

Restore button 6 
Reveal Formatting Task Pane 96 
Row 

Adjust Height 164, 165 
Boundry 164, 165 
Marker 164, 165 

Ruler 5, 6, 82, 114, 120, 121, 122, 123 
Change margins 134, 135, 136 
Indent markers 120, 121, 122, 123 
Print Preview 82, 83, 84 

S 

Save 
AutoRecover 15, 18 
Button 15, 17 
Dialog Box 16, 17 
Document 15, 16, 17 
Document Recovery 15 
File 15 
Options 16, 17 

Screen 
Icons 5 

Scroll Bars 5, 6, 39, 40, 41 
Scroll Box 39, 40, 41 
Section 

Formatting 96 
Select 

Entire Document 102 
EXT 42, 43, 44 
F8 42, 43, 44 
Selection bar 42, 43, 44 
Text 42, 43, 44 

In a table 159, 160 
Using the keyboard 159, 160 
Using the menu 159, 160 
Using the mouse 159, 160 

Set 
Margins 134, 135, 136 

Shading 
Format table 166, 167, 168 

Shortcut 
Key 12 
Menu 12, 14 

Show 
Button 28 

Shrink to Fit 82 
Single-sided documents 141, 142, 143 
Smart Tag 

Paste 61 
Sort 

Cells 155, 156, 157 
Spacing 

After 118, 119 
Before 118, 119 
Line 118, 119 
Paragraph 118, 119 

Spelling 
Checking 11, 36, 37, 38 

Spelling and Grammar 
Button 36, 37, 38 
Dialog box 36, 37, 38 

Split Windows 59 
Standard Toolbar 5, 7 

Print button 85, 86 
Start 

Word 4 
Status bar 5, 6 
Subscript 103, 104 
Superscript 103, 104 
Switch 

Documents 22, 23, 25 

T 

Tab 
Custom tab stop 120, 121, 122, 123 
Default tab stop 120, 121, 122, 123 

Table 
Add and Delete Columns 162, 163 
Add and Delete Rows 162, 163 
Adjust column width 164, 165 
AutoFormat 166, 167, 168 
Border format 166, 167, 168 
Cell 150 
Create 150, 151, 152 
Draw 151, 152, 153, 154 
Edit text 161 
Forms 150 
Gridlines 151, 152, 153, 154 
Insert 151, 152 
Insert text 158 
Move and copy text 161 
Navigate 158 
Select text 159, 160 
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What is a table? 150 
Tables and Borders Toolbar 153, 154, 155, 

156, 157 
Task Pane 5, 6, 7, 22, 23, 24, 25, 26 

Clipboard 61, 62, 64, 65, 66, 67, 68 
Reveal Formatting 96 

Taskbar 22, 23, 25 
Template 25 
Text 

Animating 103, 104 
Character Spacing 103, 104 
Copy 67, 68 
Cut 64, 65, 66 
Deleting 47 
Edit 9 
Enter 9, 10, 11 
Formatting 96 
Inserting 45, 46 
Move 64, 65, 66 
Overtyping 45, 46 
Replacing 45, 46 
Selecting 42, 43, 44 
Type 9, 10, 11 

Tile 59 
Tiled Windows 59 
Title bar 5, 6 
Toolbar 5, 6, 7 

Drawing 5, 7 
Formatting 5, 7, 98, 99, 100, 101, 102 
Standard 5, 7 
Tables and Borders 155, 156, 157 

Type 
Text 9, 10, 11 

Typeface 101, 102 
Typing Replaces Selection 45, 46 

U 

Underline Styles 104 
Undo 48 

Button 48 
User Dictionary 36, 37, 38 

V 

View 
Buttons 5 
Changing the 5 
Full Screen. 82 
Header/Footer 141, 142, 143 
Normal 80, 81 
Online Layout 80 
Outline 80 
Print Layout 80, 81 
Print Preview 80, 82, 83, 84 
Ruler 82 
Zoom 80, 81 

View Ruler button 82, 83, 84 

W 

White space 80 
Window 

Active 59 
Application 5, 6 
Controlling 59 
Document 5, 6 
Manipulating 59 
Menu 22, 23, 25 
Moving 59 
Multiple 25 
Splitting 59 
Tiled 59 

Wizards 25 
Word 

Close 30 
Exit 30 
Start 4 

Word processor 
Benefits 2 
Features 3 

Word wrap 9 

Z 

Zoom 80, 81 
Print 82, 83, 84 

 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 



Character Formatting 

To format or unformat... Press the key combination...
bold CTRL B 
italic CTRL I 
underline CTRL U 
double underline CTRL SHIFT D 
word underline CTRL SHIFT W 
small caps CTRL SHIFT K 
all caps CTRL SHIFT A 
toggle case SHIFT F3 
increase font size CTRL ] 
decrease font size CTRL [ 
superscript CTRL SHIFT = 
subscript CTRL = 
hidden CTRL SHIFT H 
remove formatting CTRL SHIFT Z 

Paragraph Formatting 

To format or unformat... Press the key 
combination... 

left align CTRL L 
center align CTRL E 
right align CTRL R 
justify CTRL J 
one line (12 pt.) of space before CTRL 0 (zero) 
single spaced CTRL 1 
one and a half line spaced CTRL 5 
double spaced CTRL 2 
increase left indent CTRL M 
decrease left indent CTRL SHIFT M 
create or increase hanging indent CTRL T 
remove or decrease hanging indent CTRL SHIFT T 
remove paragraph and font formatting CTRL Q 

Word Level 1 
Quick Reference Card 

To... The steps are… or use the 
Shortcut… 

start Word Click: Start button 
Choose: Programs 
Click: Microsoft Word 

double-click Word 
shortcut icon on 
the desktop. 

save a 
document Click: Save button  

CTRL S 

print a 
document Click: Print button  

CTRL P 

close a 
document Click: Close button  CTRL W 

open a 
document Click: Open button  

CTRL O 

create a new 
document Click: New button  

CTRL N 

use Help Type question in Help box F1 
exit Word Choose: File 

Choose: Exit 
ALT F4 

display/hide a 
toolbar 

Choose: View 
Choose: Toolbars 
Select: toolbar to 
display/hide 

Right- 
Click: any toolbar 
Select: toolbar to 
display/hide 

view Task 
Pane 

Choose: View 
Choose: Task Pane 

 

Special Keys 

To... Press the key 
combination… 

Or press the 
button… 

Spell/Grammar Check F7 
 

Thesaurus SHIFT F7  
Undo CTRL Z  

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 



Editing Text 

To… The steps are… 
insert new text Position: insertion point at desired 

location 
Type: new text 

replace selection with new text Select: text to be replaced 
Type: new text 

delete a character to the right Press: DELETE 

delete a character to the left Press: BACKSPACE 

Scrolling with the Keyboard 

To scroll to the… Press the key 
combination… 

beginning of document CTRL HOME 

end of document CTRL END 

beginning of current line HOME 

end of current line END 

up a screen PAGE UP 

down a screen PAGE DOWN 

beginning of next word CTRL RIGHT ARROW 

beginning of current or previous word CTRL LEFT ARROW 

beginning of current or previous 
paragraph 

CTRL UP ARROW 

beginning of next paragraph CTRL DOWN ARROW 

go to (page number) CTRL G or F5 

Selecting Text with the Mouse 

To select… The mouse action is… 
a character drag over the character. 

a word double-click anywhere in the word. 

a line click once in the selection bar. 

a sentence hold CTRL and click in the sentence. 

a paragraph triple-click in the paragraph or double-click in the 
selection bar. 

entire document press CTRL A or triple-click in selection bar. 

any size 
selection 

click and drag, or click at the beginning of the 
text, press SHIFT, and click at the end of the text. 

non contiguous 
text or objects 

hold CTRL and click text or objects until all are 
selected. 

Move or Copy Text 

Cut/Copy & Paste Method Shortcut Key 
Select: text  

Click: Copy button  

or Click: Cut button  

CTRL C 
 
CTRL X 

Position insertion point at desired location  

Click: Paste button  
CTRL V 

 Move text using drag-and-drop. 
Select: text to be moved 
Drag: selection to new location 

 Copy text using drag-and-drop. 
Select: text to be copied 
Hold: CTRL (and keep holding until after dragging) 
Drag: selection to desired location 
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